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Revision History 
 
Revision 1.1: 
 

• Added the footnote on page 6, that details the extra connector on the SupaSmart/Nova 
board. 

 
• Changed the highlighted text in the following sentence found on page 8  0: Press the 

(Download) PC button on the ChronoLog unit (This will put the ChronoLog device in a 
download mode for approx. 30 seconds).
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The ChronoLog System 

Introduction 
 
The ChronoLog unit is an add-on device for the SupaSmart receiver. It allows time-barring and 
transaction logging to be added to the SupaSmart system. Hence the SupaSmart system can be 
easily upgraded from a group management system to an access control system with the addition 
of the ChronoLog unit. The existing transmitter-receiver infrastructure is compatible with the 
system1. This offers a cost effective solution to upgrading to an access-control system. 
 
The ChronoLog is connected to the SupaSmart using a 4-wire connector that plugs onto the 4-
way port on the SupaSmart board. Every time a valid transaction is received by the SupaSmart, 
information pertaining to the transaction is sent to the ChronoLog (If it is present on the 4-way 
port). This information is validated against the time-barring information onboard, and the 
transaction is stored with a time and date stamp. A reply is sent to the SupaSmart indicating 
whether access should be granted, based on the validation against the time-barring information. 
 
The Time Barring function is configured with the PC software supplied with the ChronoLog 
unit. This software allows the user to configure time zones that can be added to the group 
definitions that exist on the SupaSmart. This information can then be downloaded from the PC to 
the ChronoLog unit. This allows for the ChronoLog to have stand-alone capability. i.e. It is not 
necessary to have the PC connected to the ChronoLog device permanently to implement time 
barring on the ChronoLog. 
 
1024 transactions can be stored by the ChronoLog on its onboard memory. This memory is non-
volatile, meaning the transactions will not be lost if the power fails on the device. The memory is 
maintained in a rolling buffer structure. This allows the ChronoLog to record the most recent 
1024 transactions. The Data Logging function requires no setup other than setting the time on the 
ChronoLog onboard clock. This is done from the PC using the time-barring software supplied. 
The system time is downloaded to the ChronoLog device when the time barring information is 
downloaded. However, if the ChronoLog unit is only going to be used as a data-logger, it is not 
necessary to configure the time barring information on the PC before downloading the time. 
 
The transactions that are logged, can be printed to a printer in real time. i.e. Every time a 
transaction occurs, the ChronoLog will stream the transaction to a printer. In addition, all the 
transactions that are stored on the onboard memory can be printed to the printer. Finally the 
transactions can be uploaded from the ChronoLog memory to a PC.    
 
 
 
 
 
 
 
 
 

                                                 
1 This only applies to systems where the SupaSmart has firmware of version 2 or better. If the firmware version 
precedes this, the SupaSmart receiver must be upgraded to be compatible with the ChronoLog unit. The SupaSmart 
version is displayed on the SupaSmart console on power-up. 
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Basic Operation 
 
The ChronoLog has 4 connectors:  
 

• A DB9 connector for a PC link.  
• A DB25 connector for a simple Centronix printer connection.  
• A 4-way connector for connection to the SupaSmart. 
• A power socket. 
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Figure 1 - ChronoLog System Connections 

 
When the ChronoLog is connected to the SupaSmart1 2, the system will start logging transmitter 
transactions. Each transaction will have a time and date associated with it, as well as the group 
information that the SupaSmart provides. For the ChronoLog to time and date stamp each of the 
transmitter transactions, a real time clock forms part of the hardware base of the system. To set 
the correct date and time on the real time clock, the ChronoLog needs to be connected to the PC, 
via the DB9 connector. Time barring information can then be downloaded to the ChronoLog, 
along with the system date and time on the PC. 
 
The printer required for data logging must support Epson mode emulation, and must be a simple 
dot-matrix printer for correct operation3. If no printer is connected to the ChronoLog, the 

                                                 
1 When disconnecting the ChronoLog from the SupaSmart, do not leave the connecting cable hanging on the 
SupaSmart port. The impedance of the connecting cable is enough to affect the SupaSmart’s normal operation. 
2 With the townhouse receiver board (SupaNova/Smart board) revision, an extra 4-way connector is located in the 
top left hand corner of the SupaNova/Smart console. This connector is intended for future expansion of the 
townhouse receiver. It supports the connection of the townhouse receiver to a PC, on a RS232 interface. This 
connector is strictly reserved for this purpose. The ChronoLog must not be connected to this interface. Instead the 
ChronoLog must only be connected to the 4-way connector located in the top right hand corner of the 
SupaNova/Smart board. This connector is labelled “Memory”. 
3 Refer to the section on printer compatibility for a list of printers that have been tested on the ChronoLog. 
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ChronoLog will still log transactions and store them in onboard non-volatile memory. To retrieve 
the stored transactions at some later date, a printer can be connected, and the ChronoLog can be 
put in a “Printer Dump” mode. This will dump the entire contents of the memory to the printer. 
 
If the ChronoLog is connected to the PC on the DB9 adapter, and the data logging software is 
installed on the PC, then the transactions can be uploaded from the ChronoLog when it is in 
“Printer Dump” mode. This is more flexible than printing the transactions to a printer as it 
allows the transactions to the filtered and sorted to find a data set of interest.  
 

Power Considerations 
 
The ChronoLog is able to derive power from three sources. The first is the SupaSmart, which 
provides a 5V line to drive the microelectronics on the ChronoLog. The second is the PC, which 
enables the user to disconnect the ChronoLog from the SupaSmart, and connect it to the PC for 
the time barring download without having to worry about powering the unit externally1. The last 
source is an external 12V DC power supply. The ChronoLog will tolerate voltages from 9V to 
15V DC, and typically draws 12mA. Hence the power supply should be rated to supply at least 
that at 12V. In addition the power socket is polarity insensitive, meaning that the positive and 
negative terminals can be connected either way. 
 
The ChronoLog cannot derive power from the printer. This means that the ChronoLog must be 
connected to the SupaSmart or to an external power supply for the printer operations on the 
ChronoLog to work correctly. It is not recommended to use the PC connection alone if the 
ChronoLog is dumping transactions to the printer. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

                                                 
1 On some PC’s, the internal drivers are not capable of supplying the necessary current to the ChronoLog. This can 
lead to the irregular operation of the ChronoLog. In these cases, an external power supply should be used with the 
ChronoLog. 
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Quick Users Guide 
 
This Quick User’s guide is intended for PC users who are familiar with the Windows 
environment, and want the very basic functionality of the ChronoLog device. It was written with 
brevity in mind, and hence many of the concepts are not fully explained. If anything is not clear 
it is suggested that you refer to the more comprehensive documentation. Furthermore, the special 
features on the software are not discussed in this guide. Refer to the relevant section in the 
comprehensive documentation for a full discussion of the features. 
 

Implementing Time Barring on the ChronoLog 
 

• Open the CD, and copy the ChronoLog Time Barring executable (ChronoLog.exe) to the 
hard-drive. The file should be copied to a new directory. 

 
• Set the required Time Zones in the Edit Time Zones dialog. 

 
• Set the group information for each group that needs to be defined. This information 

includes linking the defined Time Zones to the groups, and adding Group Names. 
 

• Download the Time Barring information to the ChronoLog unit. To do this: Connect the 
ChronoLog to the PC with the cable supplied.  The cable must be attached to COM 1 on 
the PC. Open the Download dialog. Press the PC button on the ChronoLog unit (This 
will put the ChronoLog device in a download mode for approx. 30 seconds). While the 
ChronoLog device is in download mode click the Download button on the PC. 

 

Implementing Data Logging on the ChronoLog 
 

• Open the CD, and copy the ChronoLog Time Barring executable (ChronoLog.exe) to the 
hard-drive. The file should be copied to a new directory. 

 
• Open the ChronoLog Time Barring application. Without setting up any of the time 

barring information, open the Download dialog. Download the default time barring 
information, and importantly the PC system date and time to the ChronoLog unit. 

 
• The ChronoLog can now be connected to the SupaSmart unit. 

 
• If a printer is connected to the ChronoLog unit while it is connected to the SupaSmart, 

the ChronoLog will log transactions to the printer as they occur. 
 

• The ChronoLog will dump its entire memory contents to the printer if the Printer Dump 
button is pressed on the ChronoLog device. 
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Uploading the Transaction records from the ChronoLog to the PC 
 

• Run the install utility for the ChronoLog Data Logging application. This will install the 
ChronoLog Data Log application on the PC. 

 
• Open the DataLog application, and configure the options in the Options dialog.  

 
• Create a new ChronoLog database file. 

 
• Connect the ChronoLog unit to the PC using the cable provided. Press the Printer Dump 

button on the ChronoLog unit to upload the memory contents to the PC. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Note: If the PC doesn’t have the correct data access drivers (Windows 95 or Windows NT, 
without Microsoft Office1) the ChronoLog will be unable to create a new database file. If this is 
the case the ChronoLog DataLog Lite application can be used to upload the transaction 
information from the PC. (Refer to the section on the ChronoLog DataLog Lite for installation 
and operation instructions.) 
 

                                                 
1 Windows 95, Windows NT, and Microsoft Office are all registered trademarks of the Microsoft Corporation. 



 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The ChronoLog Time-Barring Application  
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Introduction 
 
The ChronoLog Time Barring application is used for a number of purposes, the most 
important of which, is as the name implies, to implement time barring access control 
on the ChronoLog. The ChronoLog will operate without the time barring 
implemented, however the use is limited to a simple data logging function. To 
implement the time barring functionality on the ChronoLog, the time barring 
information must be configured on the PC, and then downloaded to the ChronoLog 
board. 
 
In addition to time barring, the Time Barring application is used to set the time on the 
onboard clock on the ChronoLog. Finally, the application is used in conjunction with 
the ChronoLog DataLog application to make the transaction data easier to analyse 
(Refer to the section on linking group information in the ChronoLog DataLog User’s 
Guide). By setting up the name information for each group on the time barring 
application the user is able to link the Group Number information back to a Group 
Name.  
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Installation 
 
To install the application, create a new folder on your hard drive and copy the 
ChronoLog.exe file to the directory. If you wish you can create a shortcut to your 
desktop (See the Microsoft Windows manual for creating shortcuts), or run it directly 
from the folder. 
 
Once the file has been copied to the hard-drive, you can run the application by 
double-clicking on it. The application should load up the main dialog as shown in 
Figure 2. 
 

View Groups Button View Time Zones Button

Edit Time Zones

Download Information to ChronoLogEdit Groups

Load Time Barring File

 
Figure 2 - ChronoLog Time-Barring Application 
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Implementing Time Barring on the ChronoLog 
 
The ChronoLog Time Barring system consists of two main entities. Time Zones, and 
Groups. 
 
There are 31 time zones. 29 of them are configurable (Time Zones 1-30). Time Zone 
0 is for all access, and Time Zone 31 is for no access. Each time zone allows you to 
specify a start time and an end time. These time definitions consist of a day of the 
week and a time. This means for example that you can set a time zone up to grant 
access from Mon 8:00 to Mon 17:00. 
 
There are 1000 Groups (Group Number 0-999). These groups are in accord with the 
groups on the SupaSmart. Each group can have a name associated with it, as well as 8 
time zones. User configured time zones must be setup before they can be added to a 
group. The only time zones that can be added to a group without defining any user 
time zones are the full-access and no-access time zones. By default every group is 
assigned the group name ‘Default’, and the full access time zone. 
 

Setting up time Zones 
 

 
Figure 3 - Time Zone Definition Dialog 

 
To set up a time zone you need to select the Time Zone button in the Define Time 
Zones frame. You can specify the time zone you are trying to set, before clicking the 
Time Zone button, by specifying a time zone number in the text box. Alternatively 
you can select the time zone in the Define Time Zone dialog (Refer to Figure 3). 
 
Once you have selected a time zone you want to add or edit in one of the two methods 
mentioned above, you need to set the zone information. Select a Start Day and Time 
by entering the information in the relevant text boxes. This time defines the point 
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where access will begin being granted. Next select an End Day and Time. This time 
defines where access will stop being granted. (The user must be careful to define the 
zones correctly. For example setting up a time zone from Monday 7:00 am to Tuesday 
5:00 pm means access will be granted from 7:00 o’clock Monday right through to 
5:00 o’clock Tuesday. It does not mean that access will be granted from 7 to 5 on 
Monday and Tuesday.)  
 
You can define more than one time zone by selecting a different time zone number in 
the text box in the Time Zone Number frame, and editing the time information as 
indicated above. Once you have finished entering or editing time zones press the Ok 
button.  
 
To view the available time zones, click the Time Zone button in the View Time Zone 
frame. This will open a Time Zone Viewer dialog (Shown below in Figure 4) with all 
the zone information displayed in a list. If you want to edit a time zone in this list, 
double click on the zone (or select a time zone and click the Edit Zone button) and 
the Time Zone Definition dialog (Figure 3) will appear.   
 

Time Zone Viewer Window

A List of Defined Time Zones

 
Figure 4 - Time Zone Viewer Dialog 

 

Setting up the Group Information 
 
To configure a group you need to click the Group button in the Define Groups 
frame. You can specify the group you are trying to set, before clicking the Group 
button, by specifying a group number in the text box. Alternatively you can select the 
group in the Group Definition dialog (Refer to Figure 5). 
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Current Group Being
Edited Group Name

List of Time Zones Associated with
Current Group

 
Figure 5 - Group Definition Dialog 

 
Once you have selected a group you want to add or edit in one of the two methods 
mentioned above, you need to set the group information. A name can be attached to 
the group, using the text box in the Group Name frame. Following this, time zone 
information can be added to the current group. This is done by clicking the Add Zone 
button. This will open up a list box, with all the available time zones that have been 
defined. Two special zones are always defined - Complete Access and No Access. 
These zones will override any other zones that have already been added to the group.  
Time zones can be selected in the list box and added to the group, by double clicking 
the time zones (or clicking the Select button in the list box). Multiple time zone 
selections can be made at any one time. Each group can have a maximum of 8 time 
zones attached to it. 

 
The group definition step should be repeated for all the groups that you want to 
define. A maximum of 1000 groups can be defined (0-999). Once you have finished 
entering or editing groups press the Ok button.  
 
To view the groups that have been configured, click the Group button in the View 
Groups frame. This will open a Group Viewer dialog (Refer to Figure 6) with all the 
group information displayed in a list. If you want to edit a group in this list, double 
click on the group (or select a group and click on the Edit Group button) and the 
Group Definition dialog will appear.   
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Group Viewer Window

A List of Defined Groups
 

Figure 6 - Group Viewer Dialog 

 
If you want to delete groups, from the defined group list, you can select the groups of 
interest, and right click on your mouse. This will open a floating menu that allows you 
to copy, paste, and delete groups. Click the Delete command to delete the groups of 
interest. 
 
In instances where you know that multiple groups will have the same time barring 
information, you can copy and paste time zones across groups. The best thing to do 
here is to firstly define the groups of interest by attaching a unique name to each of 
the groups. Next define time zones for one of the groups. Now open up the Group 
Viewer dialog and select the group where you have defined the time zones. Right 
click on the group and select the Copy command. This will copy the time zone 
information (The group name will not be copied). Once you have copied a group, 
select the group/s that you want to copy the time zone information to, right click and 
select the Paste command. This will update all the selected groups with the time zone 
information. 
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Downloading the Time Barring information to the ChronoLog 
 
Once the above processes are complete, the information can be downloaded to the PC. 
This is done by clicking the Download button on the main dialog. This will open a 
Downloading dialog (Refer to Figure 7). The current system date and time will be 
downloaded to the ChronoLog by default. If you don’t want to download the time and 
date, deselect the Download PC Time option. Connect the ChronoLog to the PC on 
COM 1. The PC Download button on the ChronoLog device must be pressed to put 
the device in the PC download mode. The ChronoLog will stay in this mode for 
approximately thirty seconds. While the ChronoLog is in this mode, click the Start 
Download button. This will initiate the download to the ChronoLog, with the 
download progress indicated on the progress bar. 
 

Download Progress Indicator

Start
Download

ButtonDownload System Date
and Time with Time Barring

Information
 

Figure 7 - Time Barring Download Dialog 
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Saving the Time Barring Information 
 
It is obviously important to be able to save the time barring information. When you 
click the Save and Exit button, the application will open a standard file dialog that 
allows you to select a directory and file name for the time barring information you 
want to save. Once you have selected a file name click the save button. The time 
barring information will be saved to the file, and the application will exit.  
 
If you save the file in the installation directory with the default filename Info.cen, 
then every time you open up the application, this file will automatically be loaded. If 
you save the file to any other location or name it something other than Info.cen then 
the file will not automatically be loaded, and you will have to load it from within the 
application. To do this click the Open Data File button on the main dialog. This will 
open a file dialog where you can select the file you want to load. 
 
In the event you want to start with an entirely new time barring configuration, then 
you should rename or delete the Info.cen file in the installation directory (if it exists). 
When you start the application, the program will search for the Info.cen file. When it 
can’t find the file, the program will configure itself for a new time barring setup. 
 
If for some reason you don’t want to save the time barring information after 
configuring it, click the Exit button on the main dialog. The program will ask if you 
are sure you want to exit without saving the information. If you confirm, the program 
will exit. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ChronoLog DataLog Application 
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Introduction 
 
The ChronoLog DataLog application enables upload of transactions stored in the 
ChronoLog memory buffer to a PC. In addition if the ChronoLog Time Barring 
application is used, transaction records can have Group Names associated with 
Group Numbers.  
 
The application is based on a database structure, to give the user the ability to filter 
and sort records easily. Both simple and complex filter functions are provided to 
narrow down searches to obtain the data set of interest. 
  
The database used by the application is compatible with Microsoft Access and 
Microsoft Excel. Thus the complex sorting and filtering functions of Access and 
Excel can be applied to the data set.  
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Installation 
 
The ChronoLog DataLog application consists of three install files. To install the 
application the Setup.Exe file must be run, (this will run the setup utility), that will 
guide you through the setup process. 
 
The setup utility will prompt you to provide an install location for the DataLog 
executable files. By default, the install location is usually C:\Program 
Files\DataLog\, however the application can be installed anywhere. 
 
In addition, the install utility will prompt you to provide a program group for the 
application. The default will suffice in most instances, however, any program group 
can be selected. 
 
The application makes use of a number of shared system “.DLL” files. If there are 
other applications open when you install the application, then it is possible that an 
access violation will occur when the install utility tries to install “.DLL” files that are 
already in use. These access violations can be ignored. However it is preferable to 
shut down any applications before installing the ChronoLog DataLog software. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Note: The install utility requires certain system files to run. On some systems, these 
files are not initially available. The install utility will update the system with these 
files, and then ask if the computer can be restarted. This is not a problem, The 
computer should be restarted, and then the install utility can be run again. 
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Application Configuration 
 

Menus

Toolbar

Status Bar
Settings

 
Figure 8 - The Main Window of the ChronoLog DataLog Application 

 
Once the application has been installed, it can be run from the Programs group on the 
Windows Start menu. The application will load a splash screen, following which the 
main application should load (Refer to Figure 8). 
 

Configuring the Output folder 
 
Before creating a database or uploading information from the ChronoLog, the system 
should be configured. The first step in the configuration is to setup where you want 
the temporary ChronoLog Database files to be created. This is done by selecting 
Options from the Tools menu. This will open the Options dialog (Figure 9). The 
dialog allows you to change the COM port, edit the temporary database path, and edit 
the channel associations (Refer to the section on channel associations). To change the 
temporary database path, either type the new path in the text box, or click the 
directory browser button (Refer to Figure 9) alongside the text box. This will open a 
window with a directory tree. The path can be selected by moving through the 
directory tree and pressing the Ok button when the correct directory is selected. 
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COM Selection Channel Setup

Temporary Database
Path Directory Browser

 
Figure 9 - Options Dialog 

 
The path information is stored in the registry when the application closes. Hence, this 
folder will now act as the temporary database folder for all future sessions, or until 
you change it to something else. 
 

Setting up the COM Port 
 
COM 1 or COM 2 can be selected in the Options dialog. When the application loads, 
information is retrieved from the registry, indicating which COM port was selected in 
the last session. This information is used to setup the COM port for this session. 
 
From ChronoLog DataLog v1.2 onwards, the COM port is dynamically changed. 
This means that the application will automatically try to release the old port and 
master the new port when a different COM port is elected in the Options dialog and 
Ok is clicked. For versions of the application less current than v1.2 see the note 
below. 
 
 
 
 
 
 
 
 
 
Note: For versions of the application less current than v1.2, if the COM port is 
changed the application must be shut down before the new COM port settings can 
take effect. 
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Database Management 

The Unique Database Structure 
 
The ChronoLog DataLog application makes use of the Microsoft Jet Database 
Engine to interpret the requests it makes on the database. The structure of the 
underlying database is specific to the ChronoLog application. Hence although the 
database engine is generic, the database structure is not. This means that when you 
create a new database, you must create it through the application, to ensure the correct 
database structure (Note that if you try to open another database in the ChronoLog 
environment, the operation will fail). 

Creating a New Database 
 

To create a new database, either use the  (New) button on the ChronoLog toolbar, 
or select the New command in the File menu. The application will open a progress 
window indicating the progress of database creation. Once the operation is complete, 
a child form will open showing a blank recordset (Figure 10). The field headings of 
the recordset indicate the data that will be retrieved from the ChronoLog. 
 

Field Headers RecordSet

Individual Records

 
Figure 10 - ChronoLog DataLog Recordset 

 
If you created a new database on a previous session and you didn’t rename the 
database when you saved it, then the temporary database will still exist under its 
temporary name. If you now try to create a new database, the application will indicate 
that there is already a temporary database under that name, and ask you if you wish to 
overwrite the existing database file. If you select yes, all the information on the old 
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file will be lost and a new file will be created. If you select no, then the application 
will not create a new database. If this is the case, and you still want to create a new 
database, you must open the old file and save it as something else before trying to 
create a new database (You can either open the file in the ChronoLog application and 
select the Save As command from the File menu, or rename the file in the Windows 
Explorer environment). 

Opening an Existing ChronoLog Database File 

To open an existing database, select the  (Open) button on the toolbar, or select 
the Open command from the File menu. This will show an Open File dialog box 
(Figure 11), where the directory and file you wish to open can be selected. Once the 
file has been selected, the application will attempt to open it. The attempt will fail if 
the database you are trying to open is not a valid ChronoLog database file.  
 
 

 
Figure 11 - Standard File Dialog 

Saving a Database 
 
The Save As Command: 
 
After working on a particular database file, you may want to save the file with a 
particular file name. To do this, select the Save As command on the File menu. This 
will open a Save As dialog, allowing you to specify a directory and file name to save 
the file. The File dialog will be much the same as that illustrated in Figure 11. 
 
The Save Command: 
 
The Save command is similar to the Save As command, except it doesn’t allow you to 
enter a file name. It saves the file information with the current name of the file. To do 
this, select the File menu and click on the Save command. This will automatically 
save the file. 
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You can also use the  (Save) button on the toolbar 
 
There is one instance where the above is not true, and that is when you are saving a 
newly created database for the first time. In this instance the Save command behaves 
the same way as the Save As command. i.e. The Save command will prompt you for a 
file name instead of saving the file directly. 
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Performing an Upload 
 
After setting up the options settings in the Options dialog (Figure 9), and opening or 
creating a new ChronoLog database, you can perform an upload from the ChronoLog 
to the PC. 
 
Connect the ChronoLog to the PC using the PC cable provided. Ensure that you 
connect the cable to the correct COM port. Ensure that you have a database file open, 
and then press the printer dump button on the ChronoLog device. 
 
The printer dump button acts as both the means to do a printer download and a PC 
upload. If both devices are connected, then the ChronoLog will send information to 
the printer and the PC simultaneously. If just the printer is connected, then 
information is only sent to the printer. Equally, if only the PC is connected, then 
information is only sent to the PC.  
 
The printer dump button on the ChronoLog board allows the entire contents of the 
onboard memory to be uploaded to the PC. This is the only way to upload information 
to the PC. The ChronoLog is unable to send information to the PC in real time. i.e. 
Transaction information can not be logged to the PC every time a transaction occurs. 
 
Once the ChronoLog printer dump button is pressed the PC should begin uploading 
information. The upload progress is indicated by the transaction records being 
dynamically updated on the recordset (Refer to Figure 10). Once all the records have 
been uploaded from the ChronoLog, the underlying database must be updated with 
the new record information. A progress dialog will indicate the progress of this 
database update. A final message box will indicate that the upload is complete, and 
that all the records have been successfully uploaded. 
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The illustration below shows a recordset that has been successfully uploaded. This 
example serves to illustrate the format of the transaction data 
 

 
Figure 12 - Recordset Example After a Successful Upload 

 
If there are no transactions stored on the ChronoLog onboard memory, then the 
application won’t update the recordset since there are no new records. However, it 
will indicate that the upload was successful. 
 
If the Application appears to be doing nothing after pressing the ChronoLog printer 
dump button, then there may be a communications problem. 

Trouble Shooting Communication Issues with the ChronoLog 
 
Make sure there are no other programs open that could be mastering the COM port 
you are using. Some programs will not release the port even after shutting the 
program down. Hence you should restart your PC to make sure that all the ports have 
been released. 
 
The ChronoLog can be run by connecting the device to the COM port alone. i.e. No 
external power source connection. However, depending on the motherboard and 
USART (Universal Synchronous Asynchronous Receive Transmit) chipset you are 
running, the ChronoLog may not run reliably with only the PC connection. You may 
have to connect an external power supply1. 
 

                                                 
1 Refer to the section on external power supplies in the ChronoLog Documentation for supply voltages 
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If the external power supply doesn’t appear to help, try disconnecting all power 
sources from the ChronoLog, and then reconnecting them and trying an upload again. 
You may also have to restart the application. If this doesn’t solve it, and you have 
repeated the process several times, then it may be a hardware problem. Check the 
cable connections. Make sure you are on the correct COM port. If you have another 
device try using it on the COM port to establish if the COM port is working correctly.  
 
If the problem persists, you either have a fundamental communications compatibility 
problem (PC hardware or software is incompatible with the ChronoLog System), or 
the ChronoLog device is damaged. 
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Sorting the Transaction Records 
 
Due to the database structure of the ChronoLog DataLog application, the transaction 
records can be sorted according to a particular field in ascending or descending order. 
This sorting process is not limited to the ChronoLog application, and can indeed be 
achieved with any generic database application (Microsoft Access, and with some 
manipulation, Microsoft Excel.) The generic database applications will allow 
powerful sorting and filtering queries against the database. The ChronoLog 
application will only allow simple numerical or alphabetical sorting against one or 
more consecutive recordset fields. This means that you can select one or more fields, 
but they must be one after the other. The fields will be sorted in precedence from left 
to right across the screen. 
 
To perform a sort, the pertinent fields must first be selected. If you are trying to sort 
against one field, then you have only to click on the heading of that field. If you are 
trying to sort across multiple fields then you must click and drag the mouse across the 
heading’s of the fields of interest. Notice that you can only drag across consecutive 
fields. You can’t drag across the first two fields, leave the third one out, and then 
include the fourth field in your sort request. 
 
Once the fields have been selected you can sort in either ascending or descending 
order. 
 

To do this use the  and  buttons to sort in ascending or descending order 
respectively.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Note: If you are sorting in ascending order, and not all of the records have been used 
(ie. There are some blank records in the recordset.), then these records will appear at 
the top of the recordset. This can obscure the pertinent information. To overcome this, 
it is suggested that you filter the blank records out first. To do this set up a complex 
filter in such a way that you include the information you want, and exclude the blanks 
(Refer to the section on complex filters if you don’t know how to use this feature). 
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The following example illustrates the sort feature, and how to sort across multiple 
fields. 
 
Assume you want to sort with respect to date and time in descending order. You 
would select the date and time fields by clicking on the date field heading and 
dragging your mouse across to include the time field. You would then select the Sort 
in Descending Order button on the toolbar and the fields would automatically be 
sorted. In terms of precedence, the first sort would sort dates. The second sort would 
sort the times for each unique date.  
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Filtering 

Filtering on a Single Instance of Data in a Field 
 
As with sorting, filtering is not limited to the ChronoLog application. Generic 
Database applications allow complex filter queries to be performed against the 
database. 
 
The ChronoLog DataLog application allows for a very simple filtering query (where 
one can retrieve the set of data pertaining to one instance of data occurring in a 
particular field), as well as a slightly more complex filter for a refined data set.  
 
To filter against a single instance of data in a particular field, you must first select the 
instance of data you are interested in. To do this, simply click in the cell of the data 
item you want to filter against.  
 

Now click the  (Filter) button on the toolbar. The filter command will find and 
display all the instances of the data item in the particular field. 
 
You are unable to implement compound filters with the simple filter command. This 
means that if you filter on an item with the simple filter, and then decide to refine the 
filter by filtering against an item in another field, the previous filter will clear before 
the new filter query is made. 

The Complex Filter 
 

Filter Against Field Filter Frame

Within Constraint
Check Box

And Check Box
Filter Condition

 
Figure 13 - Complex Filter Dialog 
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The complex filter dialog (Shown in Figure 13) is accessed by opening the Tools 
menu and clicking on the Complex Filter command. This will open the Filter dialog 
that allows you to setup the query. You are able to setup a filter query with a 
maximum of 3 mutually inclusive conditions. This means that you can filter against 
three fields of data, and each of the conditions in each of the fields must be valid for 
the filter to display that transaction record (Refer to Figure 14). The condition for 
each of the mutually inclusive events, can be either an exact match, or within a data 
set range. 
 

Entire Data Set

Condition 1 Condition 2 Condition 3

Set 1 Set 2 Set 3

Mutually Inclusive Operator

Set 1

Set 2

Set 3

Complex Filter
Result

 
Figure 14 - Venn Diagram of Complex Filter Logic 

 
To specify an event, first select a field that you want to filter against. Next select the 
type of condition. The Within Constraint option must be selected if the condition 
must be within a data set range. 
 
Next specify the condition. Either an exact match, or within a range. 
 
If you want more than one conditional set, select the And option below the filter 
frame (Refer to Figure 13). This will enable the next event frame, where the process 
can be repeated. Once the query has been setup to your satisfaction, press the Ok 
button. 
 
The complex filter doesn’t support compound filters. i.e. You can’t filter for a data set 
with the complex filter, and then try to perform another filter on that data set to refine 
it. The first filter will clear before the second one is implemented. 
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When specifying conditions, the following points should be kept in mind: 
 

• Number conditions are specified as standard numbers.  
 

• When specifying a ‘within constraint’ condition that refers to a number field, 
the constraint will find all the numbers greater than or equal to the lower limit, 
and less than or equal to the upper limit. For example, suppose you want to 
filter for group numbers 4, 5 and 6. The lower limit would be 4, and the upper 
limit would be 6. Conversely, the filter would return nothing if you specified 
the lower limit as 6, and the upper limit as 4. This is because it is impossible to 
have numbers greater than or equal to 6, and less than or equal to 4 in the same 
data set.  

 
• Text strings should be entered without any additional formatting. i.e. The 

string shouldn’t be enclosed in inverted commas, etc. When entering a text 
string condition, the condition is not case sensitive. 

 
When specifying a Within Constraint condition that refers to a text field, the 
filter is made based on strings within alphabetical limits. For example if you 
wanted all the group names beginning with A, B or C, the lower constraint 
would be A, and the upper constraint would be C. The filter would return no 
values if the lower constraint was C and the upper constraint was A. 

 
• The Access day field is handled as a text based string, and hence all the text 

based filter conditions apply. This is important to keep in mind when 
specifying a Within Constraint condition that refers to the day field. i.e. You 
can’t specify a constraint where you want all the entries between Monday and 
Wednesday, since it will return all the values alphabetically ordered between 
Monday and Wednesday (i.e. Monday, Saturday, Sunday, Thursday, Tuesday, 
Wednesday). 

 
• When specifying dates, the valid entry cases are best indicated with an 

example. Suppose you want to filter for all the entries that occurred on the 26 
March 2001. The following would all be valid date input formats: 

 
26 March 2001 
26 Mar 2001 
26-03-2001 
26 03 2001 
26/03/2001 
03/26/2001 (Month and day reversed, except in ambiguous cases.) 

 
One must keep in mind that these input formats apply to a computer with 
regional date format settings set to dd-mm-yyyy. If your regional settings are 
different (Day and month reversed) then your input formats would be different 
(You would enter month first and then day). In addition, the above formats 
could all also be used with only the least 2 significant digits of the year (01 as 
opposed to 2001). 
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Within Constraint conditions for dates are handled by specifying the older 
date as the lower limit, and the newer date as the upper limit. 

 
• Specifying times, is again best illustrated with an example. Suppose you want 

all the entries that occurred at 16:00 exactly. The following would all be valid 
entries for that time condition: 

 
16:00 
16:00:00 
4:00pm 
4:00 pm 

 
Within Constraint conditions for times are handled by specifying the older 
time as the lower limit, and the newer time as the upper limit. 

 
The following example is provided to illustrate the use of the complex filter: 
 
Suppose you have the ChronoLog installed on the main gate of a town house complex. 
The system has been in use for some time, and you have just uploaded the latest gate 
access information to the PC. In addition you have linked the group information to 
the transaction database (See linking group information, if you are not familiar with 
the process).  
 
There has been an enquiry made by the body corporate to establish whether Joe 
Bloggs entered or exited the main gate on the 27/08/01 between 18:00 and 20:00 in 
the evening. 
 
You could establish whether or not this was true by manually processing every entry 
to see whether Joe Bloggs used his transmitter at this time. However it is easier to use 
the complex filter. 
 
The first condition that needs to be in place on the complex filter is the name of the 
individual. Hence in the first filter frame, select Group Name from the drop down list 
box. Next specify that you want to filter for all names equal to Joe Bloggs in the 
Equal To text box. 
 
The next condition that needs to be in place is the date of interest. First select the And 
button below the first filter frame. This will open up the second filter frame for user 
input. This frame should be used to select Access Date from the drop down list box. 
Enter 27/08/01 in the Equal To text box. 
 
The last condition is the time condition. Clearly this is a within constraint condition. 
First check the And box to reveal the last filter frame. Select Access Time from the 
drop down list box. Now check the Within Constraint check box in the frame. This 
will reveal another entry box. In the From box, enter 18:00, and in the To box enter 
20:00. 
 
The conditions for the complex filter example should appear as they do in Figure 15 
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Figure 15 - Complex Filter Example 

 
Press the Ok button, and the recordset will indicate all the occasions where Joe 
Bloggs used his transmitter on the 27/08/01 between 18:00 and 20:00. 
 
Using the example dataset shown in Figure 17 the results of the complex filter are 
shown below 
 

 
Figure 16 - Result of the Complex Filter Query on the Example Dataset 

Clearing the Filters 
 
If you have filtered for a set of data, using either of the two filtering features, and you 
want to return to the original set of data you can clear the filter using the clear filter 
command. 
 

Either click the  (Clear Filter) button or select the Clear Filter command in the 
Options menu to clear the original filter. If there is no filter in place, and you use the 
clear filter command, no operation will be performed. The clear filter command will 
not reset the ordering of the data if you have sorted the data. 
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Linking Group Information 
 
The concern with Data logging systems is that it is often costly to implement name 
logging information on the data logger. This is because a large amount of non-volatile 
memory is required to store the name information. Hence in most cases a unique 
number is associated with the name information. However, if you are trying to 
analyse the transaction recordset, it is very difficult to identify who gained, or was 
denied access based on a unique number alone. The hardware of the ChronoLog is no 
different. 
 
However, if the group naming information is configured correctly on the ChronoLog 
time-barring application, then one is able to automatically link the group name 
information to the uploaded data record. This is extremely useful to anyone who is 
trying to monitor the access transactions. 
 
As mentioned above the first step in setting up the group link, is to ensure the 
integrity of the information in the ChronoLog Time-barring application. This means 
that the Group Name field must be filled in for every group that you intend to be able 
to identify by name. This group information is stored in a file with a “.CEN” 
extension when you close the ChronoLog Time-barring application. 
 
When you have uploaded a new data record, and you want to link the name 
information to it, you must open the Tools menu and select the Link Group 
Information command. This will open a standard file dialog box allowing you to 
specify the file that you saved with the “.CEN” extension. Once you have found and 
selected the file, the application will begin to link the group name information. The 
progress will be indicated on a progress bar. Once the information is linked the 
Group Name field will be automatically updated with the group name information. If 
you use this database file for future uploads, the previous transaction record will be 
deleted, but the linked information will not. Hence, once the latest upload is complete, 
the group name information will automatically be displayed. 
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Figure 17, below illustrates linked group name information 
 

 
Figure 17 - Recordset Example with Group Name Information Linked 
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Channel Associations 
 
When you are making use of more than one of your channels on the SupaSmart 
receiver, it is often useful to know what the channels are controlling. For example you 
may have Channel 1 associated with the main gate, Channel 2 associated with the 
garage door, and Channel 3 associated with the panic button on your alarm system. 
When you do a transaction upload it is difficult to remember exactly what channel is 
associated with what. This is where the channel association feature comes in. 
 
To implement channel associations, open the Options dialog by selecting the Options 
command in the Tools menu. On the Options dialog select the Altered Channel Info 
check box (Refer to Figure 9) and click on the Channel Setup button. This will open 
a Channel Setup dialog (Figure 18) with the ability for you to alter the way the 
channel information is displayed when you do an upload. 
 

 
Figure 18 - Channel Association Dialog 

 
Edit the channel fields and click Ok when you are done. The channel associations are 
now assigned. Every time you upload transaction data from the ChronoLog the 
channel information will be displayed with the new associations. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Note: Existing transaction uploads cannot have new channel associations defined. 
 



 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The ChronoLog DataLog Lite Application 
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Introduction 
 
The ChronoLog DataLog Lite is intended to be used in instances where the operating 
system of the PC doesn’t have the data access drivers to support the database in the 
DataLog application. The DataLog Lite is text based. This means that sorting and 
filtering functionality, associated with most database structures, is not available.  
  
You can view the text file that is created in any application that will read a “.txt” file. 
Programs like Notepad, WordPad, Word, etc will all open the file. In addition you 
can import the file into Microsoft Excel, which will then give the flexibility that a 
database structure has. 
 

Installation 
 
The ChronoLog DataLog Lite application consists of three install files. To install, the 
application the Setup.Exe file must be run. This will run the setup utility that will 
guide you through the setup process. 
 
The setup utility will prompt you to provide an install location for the DataLog Lite 
executable files. By default, the install location will probably be C:\Program 
Files\DataLogLite\.  However the application can be installed anywhere. 
 
In addition, the install utility will prompt you to provide a program group for the 
application. The default will suffice in most instances. However any program group 
can be selected. 
 
The application makes use of shared system “.DLL” files. If there are other 
applications open when you install the program, then it is possible that an access 
violation will occur when the install utility tries to install the “.DLL” files that are 
already in use. These access violations can be ignored, however it is easier to shut 
down any applications before installing the ChronoLog DataLog Lite software. 
 
 
 
 
 
 
 
 
 
 
Note: The install utility requires certain files to run. On some systems, these files are 
not initially available. The install utility will update the system with these files, and 
then ask if the system can be restarted. This is not a problem, the system should be 
restarted, and then the install utility must be run again. 
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Setting up the Application 
 

File Name and Path for
Text based Data Log

COM Port Selection

 
Figure 19 - ChronoLog DataLog Lite Application 

 
When the application opens, a small dialog (As shown in Figure 19 above) allows you 
to select a COM port and file name for the text file that is generated when you 
perform an upload from the ChronoLog device. Select the COM port that the 
ChronoLog is connected to. Select a file by clicking on the text box. This will open a 
file dialog that allows you to select a directory and filename to store the text based 
information. 

Initiating an Upload 
 
To implement an upload, press the Printer Dump button on the ChronoLog device. If 
this is successful, and the ChronoLog is communicating with the PC, a progress 
dialog box will open to indicate the progress of the upload. Once this is complete the 
text file can be opened in a text viewer. 
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Operating System Compatibility 
 
 
 

 ChronoLog 
Time Barring 

ChronoLog 
DataLog 

ChronoLog 
DataLog Lite 

Windows 95 
 á  á 

Windows 95 with 
Microsoft Office á á á 

Windows 98 
 á á á 

Windows 98 with 
Microsoft Office á á á 

Windows 2000 
 á á á 

Windows 2000 with 
Microsoft Office á á á 

Windows NT 
 á  á 

Windows NT with 
Microsoft Office á á á 
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Printer Compatibility 
 
 
The ChronoLog device has been tested and confirmed to work with the following 
printers: 
 
Epson Printers 
 
LX-300 
LX-400 
 
Seikosha Printers 
 
SP-2400 
SL-270 
 


